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About the 

 

Information Alley

 

The

 

 

 

Information Alley

 

 

 



 

 is 
a publication of Apple 
Computer, Inc., Support 
Information Services. The 
goal of the 

 

Information Alley

 

 
is to help you get full use of 
your Apple computers, 
peripherals, and software.

 

Where to Find the 

 

Information 
Alley

 

The 

 

Information Alley

 

 is 
available to anyone through a 
variety of online services and 
Internet list server capability. 
For a complete list of where 
to find the 

 

Information Alley

 

, 
call the Apple Fax line at 1-
800-505-0171 and request 
document #20720. You can 
also get an index to back 
issues by requesting 
document #20719. 
Optionally, you can search 
the Technical Information 
Library; use “information 
alley” as the search string. 
Select article title 

 

Information Alley: Online 
Services it is Posted To

 

 or 
article title 

 

Information 
Alley: Index of Past Issues

 

.

 

Submissions and Letters

 

We welcome articles that 
help Apple computer users 
become more knowledgeable 
about the functionality of their 
systems, explain or illustrate 
complex features or 
functions, or that describe 
technical tips or techniques. 
Send submissions to:

 

Information Alley

 

Apple Computer
1200 East Anderson Lane
MS 212-STI
Austin, TX 78752

Fax: (512) 908-8018
email: alley@apple.com

We also welcome letters to 
the editor and suggestions
for future articles. Please 
send all letters to the 
preceding address.

 

Copyright Notice

 

This newsmagazine is 
copyrighted, with all rights 
reserved. Individual articles in 
this newsmagazine may be 
reprinted, in their entirety, 
without prior written 
permission from Apple as long 
as full credit is given to Apple 
Computer and the 

 

Information Alley

 

 

 

is listed as 
the source of the information.

You must have prior written 
permission from Apple 
Computer to excerpt or 
paraphrase portions of articles 
from this newsmagazine. For 
permission, contact: 

Janet Christian, Editor

 

Information Alley

 

 
Apple Computer
1200 East Anderson Lane
MS: 212-STI
Austin, Texas 78752

Voice: (512) 908-8975
Fax: (512) 908-8018
email: alley@apple.com

 

Trademarks

 

The Apple logo is a trademark of 
Apple Computer, Inc., registered in 
the U.S. and other countries. 
Apple, the Apple logo, APDA, 
AppleLink, AppleShare, AppleTalk, 
A/UX, EtherTalk, HyperCard, 
HyperTalk, ImageWriter, 
LaserWriter, LocalTalk, Macintosh, 
and ProDOS are trademarks of 
Apple Computer, Inc., registered in 
the U.S. and other countries.
Apple Desktop Bus, Balloon Help, 

Disk First Aid, Finder, SuperDrive, 
Information Alley, “Get off the 
Highway and Into the Alley”, and 
TrueType are trademarks of Apple 
Computer, Inc.

Classic is a registered trademark 
licensed to Apple Computer, Inc.

AppleCare is a service mark of 
Apple Computer, Inc., registered in 
the U.S. and other countries.

All other products mentioned in this 
newsmagazine are trademarks of 
their respective companies. 
Mention of third-party products is 
for informational purposes only and 
constitutes neither an endorsement 
nor a recommendation. Apple 
assumes no responsibility with 
regard to the performance of these 
products.

Apple Computer, Inc., products 
(hardware and software) described 
in this newsmagazine are subject to 
update and change. This news- 
magazine makes no assurance that 
functions and technical information 
described here is not superceded 
by subsequent releases of the 
product described.
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By Janet Christian

Since Apple requires no written 
permission to redistribute or translate 
(into another language) the 

 

Information Alley

 

, we are always 
hearing “through the grapevine” about 
ways in which this is happening. For 
example, we recently learned that, in 
France, 

 

Mac Universe

 

 magazine 
bundles a CD with each of their issues – 
and they include multiple issues of 

 

Information Alley

 

 on each CD. We have 
heard that the 

 

Information Alley

 

 is 
being translated into French and 
German, but have not been able to 
verify this as yet.

We are in the process of trying to 
evaluate just how widely distributed the 

 

Information Alley

 

 is at this point. We 
would greatly appreciate hearing from 
you if you are aware of a distribution 
channel or language translation that we 
haven’t already reported on in a 
previous issue (which are too numerous 
to list here). If you aren’t sure whether 
we’ve previously listed a particular 
channel or translation, please let us 
know anyway – we would rather hear 
about it twice than not at all. Please see 

 

Inside Information

 

 on Page 2 for our 
address and telephone and fax numbers.

If you are translating the 

 

Information 
Alley

 

 into another language, please 
share a copy of each translated issue 
with us. We would like to distribute 
these translations to our regular online 
services, so that they are available to a 
wider audience.

As usual, as we learn of new 
distribution channels and language 
translations, we will let you know. As 

we’ve oft repeated, our goal is to 
provide the 

 

Information Alley

 

 to as 
many readers as possible, in as many 
ways as possible. 

 

Adobe Acrobat Tip

 

If you use SuperATM and still want to 
read the 

 

Information Alley

 

 via Adobe 
Acrobat, copy the font database from 
the System Folder to another location 
(such as the desktop) prior to installing 
Acrobat. Acrobat installs a tiny ATM 
database during installation. If you have 
the SuperATM database in your System 
Folder, Acrobat overwrites it. After you 
have installed Acrobat, copy the saved 
font database back over the ATM that 
Acrobat installed.

 

Issue Date Now on Every Page

 

We’ve made one minor format change 
with this issue – you may notice that the 
issue date is now included on the 
bottom right of every page. Since we 
earlier added the page number to the 
top center of each page, there was no 
real reason to maintain it on the bottom 
of the page as well. Therefore, you can 
now tell the publication date on those 
pages you might print out to keep. 

 

Modified Feedback Form

 

We’ve slightly modified our feedback 
form to provide us with information 
about the version of the 

 

Information 
Alley

 

 you are reading. We always 
appreciate receiving feedback forms 
from our readers. 

 



 

Thoughts from the Alley Cat (Editor)

 

Seeking Distribution and Translation 
Information
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From the Technical Information Library

Many Apple computer users
have wondered what an
F-line instruction is
and why a bad one
interferes with the
operation of a
Macintosh.

 

Example Scenario

 

For example, under 
System 7.x, a user 
has a particular 
program operating 
most of the time, 
and occasionally this 
program launches 
another program 
and quits itself. 

The other program then executes, and 
then relaunches the original program. 
This works fine the majority of the time, 
however, sometimes one or the other of 
the switch-overs results in the error 
“Bad F-line Instruction”, with the Finder 
being the application reported as having 
the error.

 

Background and Ideas

 

F-Line instructions are used to access 
attached processors such as a floating-
point math co-processor. It could be 
that the system is having a problem 
with the math chip; it could also be 
erroneous instructions are being 
handled in this way.

A bad F-Line instruction is a bad 
Floating Point Unit (FPU) call. However, 
when you see this on Central Processing 
Units (CPUs) without FPUs, or in 
applications that do not support an FPU, 
then it is probably a spurious error 
(basically, a faulty error message) 
generated – possibly because some data 

was executed that happened to have an 
F in the top nibble, or some similar 
situation. This problem has occurred on 
the Macintosh SE (which has no FPU) 
when loading a WDEF without sufficient 
memory to do so.

The error could be caused by some bad 
code in the application which is calling 
a processor that is not present or calling 
a memory location that is not there. 
There may be a corrupted application or 
an Extension causing some spurious 
memory problem.

A possible solution is to remove and 
reinstall the application and/or remove 
and reinstall the system software. 

 



 

What is an F-Line Instruction?

 

Tips and Tidbits

Disinfectant

 

Select 

 

About Disinfectant

 

, and 
pull a menu down and hold it to 
pause the advancing virus names 
while the music plays (to prevent 
the foot from arriving too soon 
and stopping the music). John 
Norstad appears in one half of the 
dialog, while in the other half an 
animated sequence of virus names 
march out as the Monty Python 
theme song plays, until they get 
stomped by a huge foot. Holding 
down a menu pauses the viruses 
but not the music, and if you hold 
the menu down long enough, the 
entire theme song (John Philip 
Sousa’s 

 

Liberty Bell March

 

) plays! 
(You may have to release the 
mouse button every now and then 
if the music does stop.) [From the 

 

1994 Macintosh/Newton Easter 
Egg List

 

 – Compiled by Brian 
Kendig. Contributed by Dave 
Claytor and Mitchell Marmel.] 
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By Joe Wilson

The LaserWriter Select 360 can be 
upgraded with more RAM (memory), 
which lets you print more complex 
documents and improves performance 
on documents that contain many fonts.

The printer’s standard memory size is 7 
MB (megabytes), 4 MB of which are 
contained on a removable SIMM (Single 
Inline Memory Module). The printer may 
be upgraded to 16 MB total (the largest 
size supported by the printer) by 

 

removing the 4 MB SIMM and replacing 
it with a 16 MB SIMM. The remaining 3 
MB of memory is disabled by the 
controller whenever a 16 MB SIMM is 
installed.

The 16 MB SIMM may be purchased from 
your Apple-authorized Service Provider. 
SIMMs must meet the following 
specifications:

• Size: 16 MB (4 Mbit x 32 bit)

• Access Time: 80 ns or less

• SIMM Type: 72-pin

• Refresh: 2K Row (11 bit x 11 bit)

SIMM manufacturers typically produce 
10 or more SIMM types for every SIMM 
size. 

There are a wide range of 16 MB SIMMs 
available. Just because a 16 MB SIMM is 
being used does not mean that it is the 
correct one for use in the LaserWriter 
Select 360. Contact the SIMM vendor to 
confirm that the proper SIMM is being 
used. 

 



 

Upgrading the LaserWriter Select 360’s RAM

 

You can now find the 

 

Information Alley

 

 on these online services and BBSs:

•

 

QuickData Services

 

 BBS (Greencastle, Pennsylvania) – (717) 597-8732

FirstClass 2.6 bulletin board. Online 24 hours/7 days a week. This is a 
completely free bulletin board.

•

 

VMUG Online

 

 BBS (Las Vegas, Nevada) – (702) 437-8684

Maintained by the Las Vegas Macintosh User Group. A FirstClass BBS. Three 
lines available at 14.4 Kbaud.

•

 

Mac Universe

 

 Magazine (France)

Each issue of 

 

Mac Universe

 

 magazine, published in France, comes with an 
information CD, which now includes back issues of the 

 

Information Alley

 

.

 

 

 

New Places to Find the 

 

Information Alley
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By Wayne Brissette

This article includes (in alphabetical 
order) the keyboard/mouse 
combinations you can use with System 
7.5. Many of these tips are documented 
in Finder Shortcuts, under Balloon Help.

 

Alphabetize Icons in a Window

Bypass Set Start-up Device 

 

To bypass the currently selected start-
up device (except on a Quadra 700), 

 

STEP ACTION

 

1 Activate the window you want to 
alphabetize. 

2 Choose 

 

By Name

 

 from the View 
menu. 

3 Choose 

 

Select All

 

 from the Edit 
menu.

4 Drag all files to the icon that 
represents the active window. 

5 Choose 

 

By Icon

 

 from the View menu.

 

start or restart the computer while 
holding down the 

 

x

 

-Option-Shift-
Delete

 

 keys.

 

Cancel a Print or Copy Job

To cancel a print or copy job 

 

x-. 
(period) keys.

Change “About This Macintosh”

To change the menu entry from “About 
this Macintosh” to “About the Finder” 
hold down Option while choosing the 
About document under the Apple menu 
in the Finder.

Clean Up Icons

Move all icons to nearest point on 
the grid

Use one of these methods:

• Select Clean Up Window from the 
Special menu.

• Hold down the Option key and 
choose Clean Up By Name from the 
Special menu (this function 
alphabetizes and aligns icons to the 
grid and each other, the same as the 
previously explained Alphabetize 
Icons in a Window tip).

Note: Available in icon views only.

Align icon to grid

Hold down the 

 

x key and drag then 
release the icon. 

Close All Windows at Startup

To close all open windows on the 
desktop at startup, hold down the 
Option key. The folders remain closed 
on subsequent startups, unless you 
open them in the Finder.

Continued on next page...

System 7 Key Combination Shortcuts
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Copy Selected Item to Clipboard

Use one of these methods:

• Select Copy from the Edit menu.

• Press the 

 

x-C keys. 

Cut Selected Item to Clipboard

Use one of these methods:

• Select Cut from the Edit menu.

• Press the 

 

x-X keys.

Diacritical Marks (Typing)

Note:With the exception of the Cedilla 
(which is a specific character), 
diacritical marks can be applied to 
almost any character. The correct 
sequence is to press the Option 
key and the key that activates the 
accent mark. The accent mark is 
applied to the next key pressed 
after this sequence.

Dialog Boxes (Using Functions)

Scroll Through List in Open Dialog 
Box

Use one of these methods:

Character Key Sequence

Grave Accent Option-`-(any character) 

EXAMPLE: lèvre

Acute Accent Option-E-(any character) 

EXAMPLE: école

Umlaut Option-U-(any character) 

EXAMPLE: Böblingen

Circumflex Option-I-(any character) 

EXAMPLE: maître

Tilde Option-N-(any character) 

EXAMPLE: mañana

Cedilla Option-C 

EXAMPLE: façade

• Click on the Up or Down arrows in 
the scroll bar. 

• Use the Up or Down arrow keys on 
the keyboard.

Find a File Quickly in an Open 
Dialog Box

Type in the name of the file.

Note:The Delay until Repeat control 
in the Control Panel determines 
how many characters may be 
entered for a File search.

Select the First File in an Open 
Dialog Box

Use the Left or Right arrow keys on the 
keyboard.

Select the Last File in an Open 
Dialog Box

Press the tilde (~) key.

Move Up File Hierarchy in an Open 
or Save Dialog Box

Click on the current disk icon or click 
on the directory name icon at the top of 
the dialog box to display the file 
hierarchy and select the one you want. 

• Press the 

 

x-Up arrow keys to move 
closer to the top-level directory. 

• Press the 

 

x-Down arrow keys to open 
a selected folder.

Disable Virtual Memory

Hold down the 

 

x key at startup. Do not 
release the key until startup is complete.

Note:This disables virtual memory, but 
loads any system extensions. 
When you restart your Macintosh, 
virtual memory is turned on again.

Continued on next page...
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Duplicate Item

Click on the item you want to duplicate 
and use one of these methods:

• Choose Duplicate from the File 
menu.

• Hold down the Option key and drag 
the icon to another folder.

• Press the 

 

x-D keys.

Easy Access (Activating/
Deactivating)

Easy Access is a function designed 
especially for the disabled. This 
function lets you lock modifier keys
(

 

x, Control, Option, Shift, Clear) 
without having to hold them down. Easy 
Access must be installed in the System 
Folder – Control Panels folder.

Activate Easy Access

Without moving the mouse, press the 
Shift key five (5) times.

Deactivate Easy Access

• Press the modifier key(s) you want to 
use (do not press modifier keys 
simultaneously unless you want to 
deactivate Easy Access).

• Press a nonmodifier key to activate a 
function.

• Press the modifier key once to 
activate it for one function (the U icon 
should now appear with an arrow 
above it).

• Press the modifier key twice to lock it 
down for more than one function (the 
U icon should now be filled with an 
arrow above it).

STEP ACTION

1 Without moving the mouse, press the 
Shift key five (5) times.

2 Press any two modifier keys 
simultaneously.

If the modifier key is locked, pressing it 
again unlocks it.

Eject Floppy Disk

Use one of these methods:

• Press the 

 

x-Y keys or choose Put 
Away in the File menu.

• Drag the floppy disk icon to the 
Trash.

• Choose Restart or Shut Down from 
the Special menu.

• Start or restart the computer, and 
hold down the mouse button.

• Press the 

 

x-Shift-1 keys to eject 
internal floppy drive 1.

• Press the 

 

x-Shift-2 keys to eject 
internal floppy drive 2 or an external 
floppy drive.

• Press the 

 

x-Shift-0 keys to eject any 
other floppy disk drives.

• Press the 

 

x-E keys or choose Eject 
Disk from the Special menu – if no 
disks are selected, these function 
ejects all floppy disks. These 
functions leave a “greyed out” floppy 
disk icon on the desktop.

Last Resort

If the disk will not eject you can insert a 
straightened paper clip into the hole 
located on the right front of the floppy 
drive. However, this may damage the 
floppy drive.

Erase Disk

The Erase Disk command under the 
Special menu erases any selected disk 
except a write protected (locked) disk or 
the disk that contains the active 
operating system.

Erase Floppy Disk

To erase the selected floppy disk use 
one of these methods:

• Select Erase Disk from the Special 
Menu.

Continued on next page...
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• Hold down the 

 

x-Option-Tab keys 
while inserting the disk.

Extension Manager (System 7.5)

To bring up the Extension Manager at 
startup hold down the Space Bar.

Force Quit an Application

Press the 

 

x-Option-Esc from within the 
application. 

Use this feature with extreme 
caution. You should definitely not rely 
on this as a usual way to quit an 
application. It is useful in the event that 
you have unsaved work in other 
applications when your current 
application hangs. By using this feature, 
you can return to the Finder and save 
the work in your other applications. 
You should restart your computer 
after using this feature.

Get Info (Using Functions)

Information

Select the icon and then use one of 
these methods:

• Choose Get Info from the File menu. 
• Hold down the 

 

x-I keys.

Lock Item

Check or uncheck the Locked box in the 
lower left corner Get Info dialog box.

Change Application Memory Size

Click in the box located next to 
Preferred Size in the Get Info dialog 
box and enter the desired size.

Note:This function sets the amount of 
RAM that is allocated to an 
application when it is launched. It 
should not be set below the 
Suggested Memory Size number.

Hide Current Application When 
Switching to Next

Hold down the Option key while 

switching applications.

Keypad Mouse (Activate/
Deactivate)

To set the keypad to control mouse 
movement, press the 

 

x-Shift-Clear 
keys.

• The 1, 2, 3, 4, 6, 7, 8, 9, keys control 
movement and direction of the 
pointer.

• The 5 key is the mouse button.

• The 0 key locks the mouse button.

• The decimal point key unlocks the 
mouse button.

Note: This function does not work on a 
PowerBook without the Mouse 
Keys extension because there is 
no keypad.

New Folder Creation

Use one of these methods:

• Choose New Folder from the File 
menu.

• Press the 

 

x-N keys.

Open a File or Folder

Click on the item you want to open and 
use one of these methods:

• Select Open from the File menu.
• Double-Click on the item you want to 

open.
• Press the 

 

x-O keys.
• Press the 

 

x-Down Arrow keys.

Paste From the Clipboard

After a Copy or a Cut, use one of these 
methods to Paste:

• Choose Paste from the Edit menu.
• Press the 

 

x-V keys.

Postscript File Dump 

This function lets you dump postscript 
files to disk rather than to the printer. 

Continued on next page...
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The Postscript Files are labeled as 
Postscript X (where X is a number from 
0 to 9). Background Printing must be 
turned off.

Note:This is for LaserWriter driver’s 
previous to 6.3. Version 6.3 and 
higher support printing to a 
PostScript file

Postscript File Dump With Laserprep

Use one of these methods:

• Select Print from the File menu.

• Press 

 

x-P. When the print dialog box 
appears, click OK. Immediately after 
clicking OK, press the 

 

x-F keys. 

Postscript File Dump Without 
Laserprep

Use one of these methods:

• Select Print from the File menu. 

• Press 

 

x-P. When the print dialog box 
appears, click OK. Immediately after 
clicking OK, press the 

 

x-K keys. 

Print

Use one of these methods:

• Select Print from the File menu.

• Press the 

 

x-P keys. 

Note:The command key function is not 
available at the Finder level.

Put Away Items

Choose Put Away in the File menu to 
place a selected item(s) back into its 
folder.

Quit

Use one of these methods:

• Select Quit from the File menu.

• Press the 

 

x-Q keys. 

Note:This command is not available 
from the Finder level. It is used to 
quit from an application.

Rebuild the Desktop

Hard Drive

Start or restart the computer while 
holding down the 

 

x-Option keys.

Floppy Disk

Insert the floppy disk while holding 
down the 

 

x-Option keys.

Note:If the floppy disk is the start-up 
disk, start or restart the computer 
while holding down the 

 

x-Option 
keys.

Screen Dump

The files are saved to disk as Picture X 
(where X is a number from 0 to 9).

Pict File Screen Dump

Press the 

 

x-Shift-3 keys.

Screen Dump to Imagewriter

Press the 

 

x-Shift-4 keys.

Dump of Active Window to 
Imagewriter

• Press the 

 

x-Shift-Caps Lock-4 keys.

Note:The Imagewriter dumps do not 
work on networked printers. 

Select All Items in the Active 
Window

Press the 

 

x-A keys.

Startup From CD-ROM

Hold down the letter c key (lower-case 
only).

On a Power Macintosh or Macintosh 630 
family (Performa 630, Performa 635, 
Performa 636, Performa 637, Performa 
638, LC 630, and Quadra 630) computer, 
this directs the computer to startup 
from the CD-ROM drive instead of the 
hard drive or floppy.

Continued on next page...
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Switch Startup Disk 

Trash (Move Something To)

Drag the selected icon to the Trash Can

Delete Files Without Warning/Delete 
Locked Files

• Hold down the Option key and drag a 
file to the Trash.

Turn Off Extensions (7.x)

Hold down the Shift key at startup until 
you see Welcome to Macintosh. 
Extensions off. 

This disables, for this startup only, any 
items that load at startup, such as 
system extensions, control panels, or 
chooser extensions. It also disables 
virtual memory, and background 
printing with PrintMonitor, and turns 
the Disk Cache down to 16K (the 
minimum). It also prevents launching 
any items in the Startup Items folder. 

Undo (the Last Editing 
Operation)

Use one of these methods:

• Choose Undo from the Edit menu.

• Press the 

 

x-Z keys.

Windows (Manipulating)

Change Size of a Window

Use one of these methods:

• Drag the size box.

• Click the zoom box to expand or 
reduce the size of a window.

STEP ACTION

1 Open the Startup Control Panel

2 Select the device you want to use as 
your startup device.

Close Active Window

Use one of these methods:

• Choose Close from the File menu.

• Click the active window’s close box.

• Press the 

 

x-W keys.

Close All Windows 

Use one of these methods:

• Hold down the Option key and 
choose Close from the File menu

• Hold down the Option key and click 
the active window's close box.

• Press the 

 

x-Option-W keys.

Move Inactive Window 

• Hold down the 

 

x key and drag on 
the inactive window’s title bar.

Return to the Finder With No 
Windows Open

• Hold down the Option key while 
starting or quitting from an 
application.

Zap the PRAM (7.x)

This operation resets parameters stored 
in Parameter RAM (PRAM).

Hold down the 

 

x-Option-P-R keys 
during the restart sequence. Your 
computer beeps for a normal startup 
and then beeps again. When you hear 
the second beep, you may release the 
keys.

Many default settings for the Macintosh, 
such as serial port speeds, default 
application font, mouse scrolling rate, 
and so on, are stored in PRAM. It is 
sometimes useful to zap the PRAM to 
clear these settings and reset them to 
default values. Reselect any customized 
values for these settings.

Note:After this operation, you may 
want to check your General 
control panel settings. If you have 
more than 8 MB RAM, also check 
your Memory control panel 
settings. 
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By Fred Widmer

Apple Computer, at the first anniversary 
of its Support Professional Program now 
provides a program upgrade and a new 
name. 

Renamed the Support Professional 
Solution Series, the new program 
includes enhancements to the original 
such as:

• Macintosh and Windows support for 
the program’s software components.

• Multiple e-mail services for Support 
Notices! and Support Briefings.

• Automatic biweekly e-mail 
notification of new Information 
Alley news magazine availability.

• A suite of Skill Module System 
applications that provide flexibility 
for developing customized learning 
paths.

• The Apple Support Library now 
contains two CD-ROMs; the Support 
Library CD and the Apple Software 
Archive CD.

• Access to interim updates to the 
Apple Support Library via WAIS.

Overview Of The Support 
Professional Solution Series

The enhanced Support Professional 
Solution Series is a one year 
subscription designed to address the 
complete technical support cycle from 
support “readiness” to response. This 
new program features two series of 
offerings, the 700 Series and the 500 
Series.

Both Series include:

• Desktop delivery of support briefings 
via CD and teleconferencing – 
featuring the Apple Support Briefing 
System.

• A bimonthly Apple Software Archive 
CD and Apple Support Library CD 
(including Apple's Tech Info Library) 
– indexed for use with AppleSearch 
client-server software.

• Support Notices! on customers’ 
choice of e-mail services.

• Apple’s bimonthly Support Journal 
and biweekly Information Alley 
electronic magazine.

• A complete Skill Module System and 
Apple Skill Module Library, which lets 
customers create customized self-
paced learning paths to ramp up 
unsupported staff or computer users.

• A path for technical escalation – The 
distinction between the two series is 
the customer's chosen path for 
technical escalation issues.

Support Professional Solution 700 
Series

The 700 Series includes priority phone 
support from senior support engineers 
in Apple’s Direct Response Center,

Continued on next page...

Apple’s Support Professional Solution Series
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featuring a target 60 second response 
time to incoming calls.

Support Professional Solution 500 
Series

Complements reseller or consultant 
technical backup services letting 
customers receive the benefit of Apple 
support systems and information and 
the multi-vendor or environment-
specific technical response services 
provided by their chosen reseller 
reconsolidating.

Key Enhancements To The 
Support Professional Solution 
Series

Ease Of Distribution

• New offerings will be available 
through resellers, higher education 
resellers, VARS or Apple Direct – 
normal ordering procedures.

• License Agreements are shrink-
wrapped. No more contracts to sign.

Special Offer 

All current subscribers and those 
placing orders between December, 1994 
and September, 1995 will receive Ziff-
Davis’ Interactive Support On Site CD on 
a bimonthly basis through December, 
1995. 

From the Technical Information Library

The latest released version of 
HyperCard is 2.2. This is the version 
returned by the Get Info command. The 
“version” property of HyperCard returns 
version information on the HyperCard 
application and stacks. On pages 645 to 
647 of, HyperTalk 2.0: The Book, by 
Dan Winkler and Scot Kamins, is an 
excellent description of the property 
and the information it returns. However, 
Claris Corporation uses a different 
numbering scheme for release versions 
of its software.

Running HyperCard 2.2, type put the 
long version. The string 02218000 
appears in the message box. This string 
shows the following:

1In this case, the 80 means it is released 
software. 

• Translating all of this using the Apple 
scheme results in 2.2.1. Claris uses 
only the major and minor revision 
number in its releases. The bug fix 
revision number translates to a “v” 
number with 0 being equivalent to 
“v1”, 1 to “v2”, and so on. 

0 2 2 1 8 0 0 0
Major revision 
number

Minor revision 
number

Bug fix revisions

Development 
stage1

Only applicable
on unreleased
software

HyperCard 2.2 Version 
Numbers Explained

Tips and Tidbits

Color Control Panel (System 7.x)

Click on the Sample Text a few 
times. The strings “by Dean Yu” 
and “& Vincent Lo” alternate. Also, 
“& Don Louv” sneaks in there every 
sixteenth click. [From the 1994 
Macintosh/Newton Easter Egg 
List – Compiled by Brian Kendig. 
Contributed by Don Louv]. 
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DOS Compatibility Card – Issues and Pointers

By Wayne Brissette

This article includes issues and pointers 
with the Power Macintosh DOS 
Compatibility Card.

User’s Guide Error on Apple 
Adjustable Keyboard 

On page 61 of the DOS Compatibility 
Card for the Power Macintosh User’s 
Guide reads “Using the Apple 
Adjustable Keyboard: If you are using 
the Apple Adjustable Keyboard, you 
cannot use key combinations made up 
of keys from the main keyboard and 
function keys (for example, Shift-F1).” 
This is incorrect, the Apple Adjustable 
keyboard works properly with a DOS 
Compatibility Card.

Press Esc Twice to Bypass RAM Test

To bypass the RAM memory test when 
you startup MS-DOS, you have to press 
the Esc (Escape) key twice, even though 
the screen instructs you only to “Press 
ESC to Bypass Memory Test”. At this 
time it is not known why you must 
press the ESC twice, but it does allow 
you to bypass the memory test.

Readme Error on Drive File Locking

On Page 6 of the Readme file, it is 
recommended that you lock the Drive 
File. Do not lock the Drive File. If you 
lock the Drive File using Get Info, the PC 
does not startup and several error 
messages appear.

Windows Calculator Uses Leading 
Space

When you copy a number from the 
Windows Calculator, it places a leading 
space in front of the number, which 
prevents you from pasting the number 
in the Macintosh Calculator. One 
workaround is to paste the number into 
a Macintosh application, then delete the 
space. Once you delete the space, you 
can paste the number into the 
Macintosh Calculator.

PC Network Extension Manager Error

When you turn off AppleTalk and 
restart, the error message “PC Network 
Extension: AgentOpen () returned 01” 
displays. This is an errant message, and 
does not cause any problems in the 
operation of either the DOS 
Compatibility Card, or your Macintosh. 
Click OK and continue.

DOSClip Not Compatible in EGA Mode

You cannot use DOSClip when in EGA 
mode. The DOS Compatibility Card only 
supports VGA modes 0, 1, 2, 3, 4, 5, 6, 
7, 14, 16, 17, 18, and 19.

All Displays Modes Not Supported

The DOS Compatibility Card does not 
support all multiscan displays. If the PC 
Setup Control Panel does not recognize 
your monitor, and the VGA resolution 
option is dimmed, your monitor may 
not be supported. In this case, your 
monitor only works in the mode the 
hardware recognizes.

Continued on next page...
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If you select Switch at Startup in the 
PC Setup control panel, when you 
choose Restart from the Special menu 
your Macintosh freezes. If you have two 
monitors and you are running Macsbug, 
a Macsbug error appears on the 
Macintosh monitor and the MS-DOS 
monitor is frozen. With only one 
monitor, you switch to the DOS side, but 
the system freezes and you are unable 
to return to the Macintosh OS.

This is a problem with AfterDark and 
not the DOS Compatibility Card. There 
are only two workarounds at this time:

• Disable Switch at Startup in the PC 
Setup control panel.

• Turn off AfterDark if you want to use 
the Switch at Startup option.

Troubleshooting Sound Problems

If you cannot get any sounds to play 
from DOS or Windows, including the 
DOS system beep, and all the Macintosh 
sounds play correctly, check the 
following:

• Ensure first that the PC Setup control 
panel has the sound set to Auto 
Enable.

• Make sure that the audio cable is 
correctly attached between the DOS 
Compatibility Card and the 
Macintosh logic board. 

• Check the Sound control panel’s 
Sound In settings.

This lets you play DOS and Windows 
sounds through the Macintosh 
speaker. 

STEP ACTION

1 Click the Options button.

2 Click on the CD icon (visible even 
if you do not have an internal CD).

3 Click the PlayThrough button.

...Continued from previous page

Do Not Restart While Copying

There are no safety checks in MS-DOS to 
prevent you from restarting MS-DOS 
while a copy is in progress. Since the 
Macintosh OS cannot determine if files 
are open in the DOS container, there is 
no way to prevent this.

The only way to prevent zero length or 
corrupted files is not to press the 
Control-Alt(Option)-Delete keys when 
the computer is copying files.

Cannot SUBST Shared Drives

You get the error message “Cannot 
SUBST a network drive” if you try using 
the MS-DOS SUBST command on a 
shared drive. There are many things 
that MS-DOS will not allow you to do 
with a networked drive, including using 
the SUBST command. This is how MS-
DOS works.

No Support For Multiple CD-ROMs

The current software for the DOS 
Compatibility Card does not support 
multiple CD-ROM devices. If you have an 
internal CD-ROM, then you cannot use 
your external CD-ROM drive when you 
are using MS-DOS.

AppleCD SC Drive Not Supported

You can use the AppleCD SC drive for 
Macintosh CD-ROM discs, but not for MS-
DOS CD-ROM discs.

This problem only occurs with the 
AppleCD SC drive. The AppleCD SC Plus, 
AppleCD 150, AppleCD 300, or AppleCD 
300 Plus drives work without a problem.

With the AppleCD SC drive, you can 
sometimes read directories, however 
trying to run applications from the disc 
results in the error message “CDR101: 
Not ready reading drive E, with Abort/
Retry/Fail.”

AfterDark 3.0 Causes Crash

When using Switch on Startup with 
AfterDark v3.0 for the Macintosh, the 
DOS Compatibility Card freezes.
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By Anthony Snyder

Sometimes a GeoPort does not connect 
to modems that do not support data 
compression, unless the GeoPort 
modem is not using data compression. 
This article discusses some possible 
reasons for this.

The default setting on Express Modem 
software and GeoPort is for the modem 
to attempt a high-speed, error 
correcting, data compressed connection 
and fall back as necessary to what the 
other modem is set to (AT command 
&q5). Also, modem register S47 is set to 
7, which enables the Express Modem to 
negotiate with the other modem on 
features such as compression.

The Problem

If you are having problems with the 
Express Modem connecting or 
negotiating a connection with another 
modem, make sure register S47 is not 
set to 0. This causes the Express Modem 
to drop a connection when the other 
modem is incapable of data 
compression connections (v42bis).

The application being used may be 
making settings without your 
knowledge. You can test connections by 
using a basic terminal program. Enter 
AT&F and press Return in the terminal 

window. Dial the other modem by 
entering one of these commands and 
pressing Return: 

• ATDT <phone number> (digital)

• ATDP <phone number> (pulse/
rotary)

For example: ATDT 555-4567

You should see the message 'CARRIER 
XXXX' followed in a few seconds by the 
message 'CONNECT XXXX'.

Some applications are written to 
immediately send data after seeing the 
CARRIER message. This behavior causes 
the Express Modem software to drop the 
connection because it is receiving data 
from the terminal program before the 
CONNECT message. The CARRIER 
message only means that the Express 
Modem/GeoPort has detected another 
modem on the line. By design, the 
Express Modem software disconnects if 
it receives data before it has a chance to 
print the CONNECT message. Some 
terminal programs send data before the 
CONNECT message to command the 
modem to abort a connection. The 
Express Modem is duplicating this 
behavior. 

A Workaround

A workaround if your application 
expects CARRIER to signify a connection 
is to add a 'W0' (a zero, not the letter 
“O”) command to the application’s 
modem initialization string. This 
instructs the Express Modem to not 
provide the CONNECT message and 
allow the application to use the CARRIER 
message as a valid connection signal.

Refer to the document titled Express 
Modem AT Commands installed by the 
Express Modem software installer for a 
complete description of modem 
commands. 

GeoPort/Express Modem Not Connecting to 
Another Modem
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By Tammy Harvey

If you are running At Ease and have it 
turned on, the desktop file will not 
rebuild. 

System 7.5 Users

Here is how to rebuild the desktop file:

STEP ACTION

1 Turn At Ease off.

2 Restart.

3 Hold down the Space Bar to bring up 
the Extensions Manager control panel.

4 Turn off all the extensions EXCEPT 
Macintosh Easy Open.

5 Close Extensions Manager 

6 Hold the Option-

 

x keys. 

7 After rebuilding the desktop, open 
the Extensions Manager and turn the 
extensions back on.

8 Turn At Ease back on.

9 Restart.

Non-System 7.5 Users

Here is how to rebuild the desktop file:

Another method of rebuilding the 
desktop requires the At Ease user to 
have Finder access. 

The recommended way to rebuild the 
desktop is with all Extensions OFF 
(especially when running virus 
protection software). Most of the time, 
holding down Option-

 

x keys on restart 
is sufficient. 

STEP ACTION

1 Turn At Ease off.

2 Restart holding down the Shift key 
to turn extensions off.

3 After you see the extensions off 
message, hold down the Option-

 

x 
keys to rebuild the desktop. 

STEP ACTION

1 Sign into that user.

2 Hold down the Option-

 

x keys 
(continue holding these keys down).

3 Select Go To Finder from the 
Options menu.

Rebuilding the Desktop When Running At Ease

Tips and Tidbits

Enchanter (Game)

Use the magic spell for “summon a 
person” to summon the game’s 
creator’s, Marc Blanc and Dave 
Lebling. They argue about fixing 
bugs and disappear. This only 
works once. 
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By Scott George

This article provides compatibility and 
feature information of Small Systems 
Computer Interface (SCSI) Manager 4.3.

New Features

SCSI Manager 4.3 adds several new 
features to the SCSI architecture of the 
Macintosh. These features include:

• SCSI 2 compliance

• Concurrent asynchronous I/O

• Disconnect and reconnect

These new features can improve the 
performance of the SCSI bus. SCSI 
Manager 4.3 is supported on all Power 
Macintosh, and 68040 Macintosh 
computers, except for the Macintosh 
630 family (Performa 630, Performa 
635, Performa 636, Performa 637, 
Performa 638, LC 630, and Quadra 630), 
and 68040 PowerBook.

SCSI Manager 4.3 is part of the ROM in 
all Power Macintosh and Quadra AV 
computers. Other 68040 Macintosh 
computers require the SCSI Manager 4.3 
system extension. 

SCSI-2 Compliance

All mandatory SCSI-2 messages and 
protocol actions, as defined by the 
initiator, are supported. However, 
optional hardware features of SCSI-2, 
such as fast SCSI and wide SCSI, are 
supported by the interface but not by 
the Macintosh hardware. This means 
that expansion cards can be designed to 
offer this functionality and SCSI 
Manager 4.3 supports these cards.

Concurrent Asynchronous I/O

Concurrent asynchronous I/O means 
that reads and writes can be requested 
and the processor is free to do other 
things until the device completes the 
request and notifies the SCSI Manager 
by using an interrupt. Multiple drivers 
can issue multiple requests; SCSI 
Manager 4.3 tries to overlap the 
operations as much as possible. 
Applications need to call the File 
Manager asynchronously to take 
advantage of the asynchronous 
operation of SCSI Manager 4.3.

Disconnect and Reconnect

Disconnect and reconnect lets devices 
disconnect from the SCSI bus while 
processing a command and reconnect 
when needed. With this feature requests 
can be sent to multiple devices and 
executed in parallel. For example, a 
driver for a disk array can send a 
request to one disk, which disconnects, 
then issue another request to a different 
disk. The two disks can then process the 
requests simultaneously, reducing the 
time needed to accomplish the task.

Continued on next page...

SCSI Manager 4.3 – Compatibility and Features
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Direct Memory Access

Direct memory access is also used by 
SCSI Manager 4.3. This capability is 
available on the Quadra 660av, Quadra 
840av and all Power Macintosh 
computers. This allows direct transfer 
of data from the SCSI bus to memory 
without going through the main 
processor. This frees the main 
processor to do something else at the 
same time as the data transfer.

Multiple SCSI Bus Support

SCSI Manager 4.3 also supports multiple 
SCSI buses. Some Macintosh models 
(such as the Power Macintosh 8100/80) 
have dual SCSI buses. These Macintosh 
computers support 14 SCSI devices (7 
on each bus) as long as the drivers for 
these devices support SCSI Manager 4.3. 
Also, Nubus and PDS cards can be 
developed to add even more SCSI buses.

Parity Detection

Parity detection is now used to check 
for errors in data received by the SCSI 
Manager. This feature can be enabled or 
disabled on a per transaction basis for 
compatibility. The original SCSI Manager 
did not check for parity errors of 
incoming data. All Macintosh computers 
generate parity for write operations.

Compatibility

SCSI Manager 4.3 is backward 
compatible with the original SCSI 
Manager. All of the original SCSI 
Manager functions and TIB instructions 
are supported except for scComp 
(compare).

Additional and programming 
information can be found in Chapter 4 
– SCSI Manager 4.3 of Inside 
Macintosh: Devices. 

By Jeff Mosqueda 

QuickTime Musical Instruments 
extension 2.0, is a major component of 
QuickTime 2.0, providing support for 
various musical instruments. 

The QuickTime Musical Instruments 
extension is now available from the 
following online services:

AppleLink

Apple Products ➝ Apple SW Updates ➝ 
Macintosh ➝ System Software ➝ Other 
System Software ➝ QuickTime Musical 
Instruments 

eWorld

Computer Center ➝ Apple Customer 
Center ➝ Apple Software Updates ➝ 
Macintosh ➝ System Software ➝ Other 
System Software ➝ QuickTime Musical 
Instruments 

Internet

Anonymous ftp site on the Internet:

ftp.info.apple.com/Apple.Support.Area/
Apple.Software.Updates/Macintosh/ 
System.Software/Other.System.Software/
QT Musical Instruments sea hqx 

QuickTime Musical 
Instruments Extension 
Available From Online 

Services
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Tell Us What You Think
Tell us what you think of the Information Alley. We want the it to be as useful for you as possible. Your feedback will 
help us reach this goal. Please fill out this form and fax, mail, or email it to the address at the bottom of this page.

Content

Were the articles interesting and informative? YES NO If NO, please explain:
______________________________________________________________________________

How was the technical depth of the articles? NOT ENOUGH ABOUT RIGHT TOO MUCH
Comments: ____________________________________________________________________

Did you find any specific article especially useful? YES NO If YES, list which one:
______________________________________________________________________________

How is the frequency of the magazine? TOO OFTEN ABOUT RIGHT NOT OFTEN ENOUGH
Comments: ____________________________________________________________________

How is the length of the magazine? TOO LONG ABOUT RIGHT NOT LONG ENOUGH
Comments: ____________________________________________________________________

Format and Layout

Which format of the magazine do you read?

COMMON GROUND (DOS) COMMON GROUND (MAC) ADOBE ACROBAT

Do the graphics enhance or clutter the magazine? ENHANCE CLUTTER
Comments: ____________________________________________________________________

Did you read the magazine online or did you print a copy? ON-LINE PRINTED COPY
Comments: ____________________________________________________________________

Please describe ways in which the Information Alley could be improved, or give us your ideas on future articles.

_____________________________________________________________________________________________

Personal Information (optional)

Please let us know who you are in case we have questions about your suggestions or comments. 

Name _________________________________________________ Telephone ___________________________
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